Data Exchange with the Country Response Information System and UN Agency Software
A Step-by-Step Guide
Data Exchange with the Country Response Information System and UN Agency Software

A Step by Step Guide

May 2006
Table of Contents

Objective 1
Introduction 1
The IXF Data Exchange Format 3
Initial Considerations 3
Export of data from CRIS to the IXF format 4
  Summary 6
  Features of CRIS 6
Data transfer between CRIS and KIDS 7
  Conclusions 10
  Features of KIDS 10
Data transfer between CRIS and DevInfo 11
  Special considerations 11
  Overview of data exchange between CRIS and DevInfo 12
  Template definition with the DevInfo template module 12
  Creation of DevInfo worksheets from an IXF file 15
  Importation of DevInfo spreadsheets into a DevInfo template 16
  Working with DevInfo Data 19
  Conclusions 22
Data transfer between CRIS and HealthMapper 25
  Special considerations 25
  Importing IXF Data with HealthMapper 25
  Creating a thematic map with HealthMapper 26
  Conclusions 28
  Features of HealthMapper 29
Summary 31
ACKNOWLEDGEMENTS

A special thanks to those that answered the numerous technical queries of the author including Stephané Vouillamoz of WHO, Ali Safarnejad of FAO, Jesper Moller of UNDP and the UNAIDS CRIS Unit.
Objective
This paper will describe current methods of data exchange between the Country Response Information System (CRIS 2.1.2) developed by UNAIDS and several other UN agency database and analysis systems, namely:

- DevInfo (v. 4.0) developed by UNICEF and UNDG
- The HealthMapper (v. 4.2 revision 4.2.4) developed by WHO
- Key Indicator Database System (v 2.1.3) developed by FAO

The capabilities of each application will be evaluated, and a rationale given for why data might need to be exchanged between the applications. Detailed steps will be provided to enable the transfer of data between CRIS and each of the applications mentioned above, using the Indicator Exchange Format (IXF).

Introduction:
UNAIDS has undertaken an ambitious initiative to provide a comprehensive information management system to store and analyze data related to the HIV/AIDS epidemic. The Country Response Information System (CRIS) is a flexible information management system that is capable of storing complex indicator data. CRIS allows users to define their own indicators and in terms of different subpopulations, target groups, geographical location and other factors. CRIS is primarily a data warehouse and collection system that allows countries or organizations to efficiently and reliably collect indicator data within their own organizations and to exchange this data with other organizations and countries. In addition to the almost limitless storage capacity of the database, analysis on indicators can be performed through user-friendly linkages to Microsoft Excel.

Although developed ostensibly to record country response indicators for Monitoring and Evaluation (M&E) of the HIV/AIDS epidemic, CRIS can be adapted to collect essentially any indicator data, even indicators that may be completely unrelated to HIV/AIDS. There is nothing to prevent the user from defining indicators related to food security, child protection, or developmental progress if so desired. This flexibility presents the possible use of CRIS as a data warehousing and collection system, not only for HIV/AIDS indicator data, but for all sorts of indicator data, from seemingly dissimilar disciplines. The flexibility of the CRIS application presents the opportunity for its use as a repository of indicator data that can be used to generate thematic maps, graphs, charts, tables and other types of analyses of indicators through external software tools.

CRIS seeks to fill a gap in data collection and organization as it applies to monitoring and evaluation. Geographical Information Systems (GIS) applications can be used to generate many different types of maps, but generally have not been created with any systematic approach to data collection. This is true of other software tools that are used to visualize and analyze data. There is a clear need for an application that is capable of collecting, organizing, and storing temporally and spatially distributed indicator data, that can eventually be used for the generation of maps and other charts. The need for good quality data is an obvious, but unfortunately often overlooked,
prerequisite to generating high quality thematic maps and analysis from data. It is this gap in data collection and organization that CRIS seeks to fill.

Other United Nations agencies have also developed their own database and analysis systems, each for different purposes depending on the mandate of the agency. However, there is significant overlap between the functionality of each of the applications, which potentially facilitates the exchange of data between them. Each of the three applications mentioned above will be described in their own sections later in this paper. Briefly, DevInfo, developed by UNICEF and the UNDG, is a database system that allows the definition of indicators similar to CRIS. DevInfo presents a user-friendly interface to the user to allow the generation of maps, charts, and tables. Other more advanced features allow the creation of custom defined indices and calculation of various statistics. The HealthMapper database system developed by the World Health Organization is a GIS and data management system that allows non-GIS specialists to visualize indicator data on maps, in combination with other factors such as population centers, roads, rivers, and health facilities. This type of analysis allows decision-makers to quickly assess where and how scarce public resources can best be allocated to combat diseases. The Key Indicator Data System (KIDS) is a mapping and analysis program developed by the Food and Agriculture Organization (FAO). KIDS is capable of generating thematic maps and charts, and can be used as both a standalone program, as well as a web server capable of presenting maps and data on the Internet. Each of these applications is flexible enough to contain essentially any indicator data regardless of the theme of the data. It is up to the end-user to decide how the data needs to be used and visualized when considering which application or combination of these applications need to be used.

In the following sections, details of each of these programs will be given, with particular emphasis given to highlighting each of the programs different capabilities. Each of the programs will be evaluated in terms of their functionalities, namely:

• **Data collection**: The ability to collect data from different organizations or administrative units within an organization in a systematic manner.
• **Stratification**: Stratification is the concept whereby units that make up an indicator are linked within the database, and can be used to automatically calculate a total. For instance, an indicator might be stratified by Gender and would therefore have a certain value for males and females. These stratification units could then be used to calculate a total (i.e. All). Please refer to the CRIS user guide for more information on stratification.
• **Graphing**: Generation of analytical graphs from indicator data
• **Tables**: Generation of meaningful tables for inclusion in reports, summaries, etc from indicator data
• **Mapping**: Generation of thematic maps (chloropleth) maps from indicator data
• **Data Exchange**: Exchange of indicator data with different users of the same program (i.e. CRIS to CRIS) or between programs (e.g. CRIS to DevInfo). In this paper, the discussion of data exchange will be limited to exchange from CRIS to other applications.
• **Technology**: A brief description of the underlying technology of each application will be provided.
The IXF Data Exchange Format

Data exchange between different database systems is a crucial, but often difficult matter. Database systems are often developed for different purposes, but often need to exchange data with one another. If one considers the multi-disciplinary nature of the HIV/AIDS epidemic, it is necessary to have data ranging from social and behavioral data, to epidemiological data, and even data related to nutrition and food security. Data from one organization may be have stored in their own database system, but may need eventually be combined with data from another system, depending on the nature of the analysis.

Several high-level interagency meetings have resulted in a common data format for the exchange of indicator data between various UN agency databases as well as other third-party systems. The Indicator Exchange Format (or IXF) is a framework to allow the exportation of data from one system (such as CRIS) and into another system (such as KIDS). The IXF format is a completely self-contained data file, that contains all information to describe indicator data, such as the indicator name, indicator description, geographical data, and various other “metadata” used to define the indicator. The IXF standard is an extensible XML schema, that allows various applications to talk to each other, while also retaining information that may be specific to each application.

Initial Considerations

Careful planning is required in order to assure the reliable exchange of data between CRIS and other applications. Data importation into a mapping program will proceed much more smoothly if all of the geoplacenames contained in the data file match exactly the place names of the map files and/or the database that data will be imported. However, it is generally possible to reconcile differences in the spellings of place names during the importation process. It is absolutely necessary however, that the total number of place names match the number of regions of a given boundary file. For instance, if a data set contains information relating to ten divisions of a given country, but the boundary file contains eleven states, it will not be possible (nor logical) to use this boundary file to map data.

Typically, geographical information relating to national and subnational administrative boundaries are stored either in ESRI’s shape file format, but can be contained in other formats such as MapInfo’s TAB format among many others. KIDS supports both ESRI and MapInfo format, while DevInfo and HealthMapper only supports shape files. Before any data is entered into CRIS, it is essential that all place names are checked carefully against those in the shape files and corresponding databases, especially DevInfo and HealthMapper. CRIS utilizes a hierarchical geodatabase developed by WHO. Therefore data exchange between CRIS and HealthMapper (also developed by WHO) is usually trouble-free, provided that place-names have not been altered in CRIS. However, place-names change often and each country should carefully check the place-names in both the CRIS geodatabase, as well as the shapefiles to be used to map data, to ensure that they are up to date and accurate.

1 The shape files that are used by HealthMapper and DevInfo must adhere to strict development standards. If the maps provided by these applications do not match the geographical information in CRIS, new maps will have to be developed. Although possible, this process is beyond the scope of this paper.
In some cases, the geographical information contained in the geodatabase distributed with CRIS may be incorrect or out of date, and may require modification. This step should be taken before any data is ever entered into CRIS.

Export of data from CRIS to the IXF format

In this section, the process of exporting data from CRIS into the Indicator Exchange Format (IXF) will be detailed. By default, CRIS cannot export data into the IXF format, unless a few changes are made to the configuration of the program. Before making any changes to the configuration file, it is highly recommended that you make a complete backup of your CRIS database. This can be done in the CRIS database system using the Administration module. Simply press “Administration” then “Backup Database”, then “Backup”.

The configuration file of CRIS can be edited by executing following statement, on most systems. In order to execute this command, press “Start” then choose “Run” from the Windows start menu. Paste or type this command into the prompt:

Wordpad “c:\Program\Files\UNAIDS\CRIS21\Common\bin\cris.config”

The CRIS configuration file should now be loaded into the Wordpad program. If CRIS has been installed in a location other than the default location (i.e. C:\Program Files\UNAIDS\CRIS21), you will have to open the Wordpad (or other text editing program) and browse to the correct location. Once the cris.config file is open, scroll down until you see a set of XML tags called “dataExchange”. Be sure that the allowCompatibleXml attribute of this tag is set to “true”. Once you have made the changes to the file, be sure to save it with Wordpad “File->Save” and exit the program.

Do not make any other changes to this file, as you may render your CRIS system inoperable. At this point, your CRIS system should be able to export data in the IXF format.
In order to export indicator data from CRIS, the export function of CRIS must be utilized. From the main menu of CRIS, click “Indicators” then “Export”. In the new browser window that appears, select “Choose custom options” from the “Select pre-defined export settings” field. Be sure that “Make compatible” is checked and “Export operands”, “Compress file” and “Export definitions” are not checked. In this example, one indicator named “HIV Prevalence-Statistic” has been selected for export. To select more indicators press and hold the “Ctrl” button on your keyboard, and click each indicator with your mouse button.

Once all the settings on this screen have been set, press “Export” to begin with the data export. Depending on the amount of data to be exported and the speed of your computer, the export process can take several minutes. Eventually, CRIS should inform you that the data has been successfully exported to a file. By default the file is located in the “C:\Program Files\UNAIDS\CRI21\Data\Export” folder. It may be easier to copy the file elsewhere for later processing. Just press “Copy file to folder” and select a new location if so desired.
Summary

The Country Response Information System (CRIS) is a user-friendly browser-based program that allows users to create and enter indicator data. CRIS utilizes the industry-standard Microsoft Desktop Engine (MSDE) database to store and retrieve information, which in effect, allows virtually unlimited storage of information. Therefore, CRIS is a particularly powerful system for the collection and storage of data. CRIS can be configured in a number of modes, from the international to the local level.

CRIS can be configured at the subnational level to collect indicator data for each administrative region in a country. This data could then be collected for all the administrative regions, and assembled into a national database. Similarly, CRIS can be configured by different organizations (i.e. NGO’s, UN, ministries or departments), each of whom can maintain their separate indicator database. The data from each organization could be collected into a central, national level database. CRIS provides a common data exchange platform through which each organization can exchange data, using a common set of reference information (i.e. Target Groups, Age Groups, Gender, etc). The data collection and organization features of CRIS are particularly powerful when compared to the other applications reviewed in this paper.

Features of CRIS

<table>
<thead>
<tr>
<th>Feature</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data collection</td>
<td>Supports distributed, systematic data collection</td>
</tr>
<tr>
<td>Graphing</td>
<td>Yes, through Excel® PivotTables</td>
</tr>
<tr>
<td>Mapping</td>
<td>No</td>
</tr>
<tr>
<td>Tables</td>
<td>Yes, through Excel® PivotTables</td>
</tr>
<tr>
<td>Stratification</td>
<td>CRIS supports two levels of stratification. Stratification units are used to calculate an overall total for a given indicator. Standard levels are Age, Gender, Urban/Rural but this can be customized.</td>
</tr>
<tr>
<td>Data exchange</td>
<td>Yes, import and export capabilities through the IXF data exchange standard.</td>
</tr>
<tr>
<td>Technology</td>
<td>CRIS is a single-user browser based application written in VisualBasic® 6.0 with HTML and JavaScript used for the user-interface. The system is capable of defining and storing a range of indicator, project and research data. The Microsoft Desktop Engine® database system is used for data storage and retrieval. CRIS makes extensive use of XML technology for data and configuration transport between systems.</td>
</tr>
</tbody>
</table>
Data transfer between CRIS and KIDS

KIDS is a highly flexible, internet-ready, multi-platform mapping application capable of displaying indicator data that has been exported to the IXF data format. A brief description of how a project is created in KIDS and the subsequent steps necessary to import data in the IXF format will be described in this section. The reader is referred to the KIDS web site (http://kids.fao.org) for the latest information of which version supports IXF data exchange and how to install and configure KIDS on your machine.

Once you have installed KIDS, a new project of the geographical area(s) for which you are interested in must be created. This can be accomplished by using the Editor feature of KIDS which is accessed from the KIDS start page by pressing the “Log In” button, highlighted below:

By default, the user name is “admin” and the password is “kids”. Once you have logged into the administration mode of KIDS, a new project can be created. Press “Administration” from the top-level toolbar of KIDS and then the “Create new project” icon as noted below. Once you have created a project, you can add geographical information to the project.

To start, create a new group in KIDS by pressing the “Map” link on the KIDS projects toolbar, and then the “Create group” icon. In this example, a new group layer called “Administrative” will be created as seen below.

Once you have created a group to contain your geographical information, you need to add the appropriate files. Press the “Import Layer” button in order to add the shape files for your geographical area of interest. In this example, administrative boundaries for a fictitious country called Popstan will be added at the first administrative level. A screen shot showing more detail can be seen on the next page.

---

2 The concept of the fictitious country Popstan is derived from the CSPro software package produced by the US Census Bureau. Visit http://www.census.gov/ipc/www/cspro for more information.
If you are using shape files, three separate files must be added to the layer in order for the information to be displayed within KIDS, namely a shape source file (ending in the extension “shp”), a compiled shape file (ending in the extension “shx”) and a database file (ending in the extension “dbf”). If your boundary files are in any other format other than shape files, please refer to the KIDS documentation for detailed instructions of how to add these vector files to a group layer. An example can be seen to the right.

The next step of the wizard will allow you to choose the geographical projection of your shape file. Choose the appropriate projection and datum, and press “Apply” to proceed.

The KIDS import wizard will allow you to choose which columns that should be used to identify and label each geographical unit. As was mentioned earlier, the place names contained in the geoplace-name database of CRIS should match those exactly of your shape files. If they do not, it will be possible to change them later. Typically, you should the column that contains the place-names themselves, as both the “Code Column” and “Label Column”. In the example shown below, the “NAME” column will be used for both the “Code Column” and “Label Column”.

Once you have selected the appropriate Name and Column Codes, click “Next” to proceed to the next step of the wizard. At this point, you can choose to import an IXF file by choosing “Associate the layer with the data set” option. Click the “Next” button, and press “Browse” in the next dialog box in order to define the path to your IXF data file as seen below.

Projections and datums are geographical concepts that define how a vector map file should be represented. If you do not know the projection and datum of the boundary file to be used, please refer to the maps original source for more information.
Click the “Next” button to proceed further whereby KIDS will allow you to match any place-names that don’t match between the map file and data IXF data file. In a typical scenario, a place-name from the IXF file did not match the place-name on the map file that had been imported into KIDS. A list places on the map that do not match are presented on the left-hand column of the dialog box. To the right of each entry that doesn’t match, is a list of all possible place-names in the data file. Simply press the drop-down box and select the appropriate place-name to link the two places. Notice that in the map file, there was a state called “Artesia” but in the IXF file, there was a place-name called “ArtesiaButWrong”. By linking these two places in this step of the Data Import wizard, the data can be displayed properly on the map.

Once all place-names have been matched (if any) click “Next”. The final step of the wizard informs the user that the data has been imported. Click “Finish” to complete the KIDS Data Import Wizard. In addition to boundary files, for your own project, you may want to add additional geographical information such as cities, roads, rivers, elevation, etc. KIDS supports a large number of vector, point, and raster formats, all of which can be displayed on a map as desired by the user. The user is referred to the KIDS documentation for detailed instructions of how to add additional geographical information to a KIDS project. Once all layers have been added to the map, an empty map should be visible within KIDS. Data can now be imported from an IXF file and displayed as a thematic map with KIDS.

A thematic (chloropleth) map of your data should now be able to be displayed through the KIDS mapping interface. If you have imported multiple indicators or if your indicator is stratified (i.e. broken down by Gender, Age Groups, etc) you can select these by choosing the desired data set through one of the extent drop-down boxes (i.e. Indicator, Age Group, Gender, etc) located to the left of the map in the KIDS interface.
Conclusions:

Overall, the exchange of data between CRIS and KIDS is quite straightforward, once a suitable KIDS project has been created. KIDS is able to handle stratified indicators, as well as to import large data sets with multiple indicators in one step. Additionally, there is no need to define a template of which indicators you want to import beforehand. KIDS is a powerful, internet ready mapping and analysis platform, with advanced architecture and an cross-platform, open-source development model.

Features of KIDS

<table>
<thead>
<tr>
<th>Feature</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data collection</td>
<td>No systematic support. All data must be imported from comma-delimited, IXF or other compatible formats.</td>
</tr>
<tr>
<td>Graphing</td>
<td>Geographic and Time Series graphs are ready by default. The user can define additional templates. Labeling control and data content of graphs is basic. Export to Excel is supported for more advanced graphs.</td>
</tr>
<tr>
<td>Mapping</td>
<td>Excellent support for thematic maps. Able to handle a large variety of raster and vector file formats.</td>
</tr>
<tr>
<td>Tables</td>
<td>Yes. Limited support for formatting, although export of table data to Excel is supported.</td>
</tr>
<tr>
<td>Stratification</td>
<td>KIDS is perhaps the most flexible of all the applications reviewed here in this regard. KIDS supports arbitrary levels of stratification. All dimensions (time periods, genders, data sources, etc) are viewed as stratification levels.</td>
</tr>
<tr>
<td>Data exchange</td>
<td>Yes, import and export capabilities through the IXF data exchange standard. The current production version of KIDS supports the import of IXF data.</td>
</tr>
<tr>
<td>Stratified indicators</td>
<td>Yes, multiple dimensions supported.</td>
</tr>
<tr>
<td>Technology</td>
<td>KIDS is an internet ready, thematic mapping application capable of displaying a variety of vector, raster and point formats. KIDS employs an advanced architecture using XML/XSL and Java Server Pages (JSP) running on the Apache Tomcat Application server. It is the only application reviewed here that is able to run on multiple platforms, including Linux, Windows®, MacOS® among others. KIDS source-code is freely distributed under the GPL license.</td>
</tr>
</tbody>
</table>
UNICEF’s DevInfo database program (v 4.0) has recently added support for the exchange of data with other UN databases via the IXF exchange format. A standalone program, known as the DevInfo Data Exchange Utility, can be used to import and export data with the IXF format. In this section of this paper, the procedures to import data from the CRIS database platform will be discussed, with special attention given to the procedures that are necessary to observe with working when with DevInfo and IXF data.

Special considerations

Unlike the other applications detailed in this paper, DevInfo requires the user to define a template for the DevInfo database, using the DevInfo Template utility. For each indicator that will be exported from CRIS, a corresponding indicator will need to be first defined in a DevInfo template. DevInfo uses an Indicator-Unit-Subpopulation scheme to classify indicators. DevInfo doesn’t employ the same use of stratification as CRIS, but instead employs an “Indicator-Unit-Subpopulation” scheme in order to detail with indicators that are stratified. However, indicators are treated within the application as separate entities with unique IUS linkages used to stratify the indicator. Therefore, if indicator data from CRIS is to be imported and the data file contains information on stratification, separate unassociated indicators will need to be created in DevInfo in order to properly represent them.

DevInfo will allow the importation of CRIS operands. Operands are defined to be the numerator and denominator of an indicator in CRIS that has been assigned a percentage value. If want to work with these operands and have exported them from CRIS, you will need to create appropriate indicators and IUS linkages for them. For percentage values, CRIS exports three indicators to the IXF file:

- A value
- A numerator
- A denominator

In DevInfo, three separate indicators will need to be created with the DevInfo template module, along with the appropriate IUS linkages. An example of this is given in the next section.

The user should be aware that special shape files are required by DevInfo that correspond to a strict protocol. Many map files are provided with DevInfo 4.0. Because of the use of different data origins, the geographic information in many countries shape files provided with DevInfo has been observed in many cases to differ from the country-maintained geographic information contained in CRIS. Therefore, if you are exporting data from CRIS into DevInfo, the map files that have been shipped with DevInfo must be carefully checked to ensure that all place-names and map boundary files are exactly the same. 4

Because a template must be defined prior to importing any data from an IXF file, the user must know exactly which indicators will be imported, what type of stratification if any these indicators might have, and if the indicators have any operands. All of these factors must be defined in a DevInfo template prior to importing any data from an IXF file.

4 The creation of map files compatible with DevInfo is beyond the scope of this document. If the map files provided with DevInfo 4.0 are not suitable for your particular country or region, new shape files must be created. Please contact the DevInfo support unit for further information.
Overview of data exchange between CRIS and DevInfo

There are several steps that are required to exchange data between CRIS and DevInfo, namely:

• Export data from CRIS in compatible mode to an IXF file
• Define a template in the DevInfo Template module with corresponding indicators, units and subpopulations.  
  
5 A compatible map file is required for this step.
• Use the DevInfo Data Exchange module to generate DevInfo spreadsheets.
• Use the DevInfo Data Entry module to import spreadsheets into a DevInfo database
• Work with the resultant database in DevInfo

Each of these steps will be detailed in a separate section below.

Template definition with the DevInfo template module

In this section, a brief description of how to create a template with the DevInfo template module will be given. The reader is referred to the DevInfo Administration documentation for further details. In this example, the process for importing a stratified indicator with operands that contains data at the first subnational level will be described. However, the same procedure should be able to be adapted to essentially any indicator, whether stratified or unstratified.

Because of the slightly different implementations of stratified indicators used by CRIS and DevInfo, it is necessary to represent each stratification component of an indicator defined in CRIS as a separate, unassociated indicator in DevInfo. For this example case, the indicator “Literacy Rate” has been defined in CRIS with a first-level stratification, “Gender”. In order to import this indicator into DevInfo, each stratification component (namely “All”, “Female”, “Male”) must be assigned a separate subpopulation in DevInfo. For percentage indicators with operands (i.e. a numerator and denominator), different units and indicators must be used in DevInfo. Since the example indicator “Literacy Rate” is a percentage-based indicator with operands, several IUS components would need to be defined in DevInfo in order to import this indicator. A table of all the IUS linkages required to represent this indicator is provided below:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Unit</th>
<th>Subpopulation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Literacy Rate (Value)</td>
<td>Percentage</td>
<td>All</td>
</tr>
<tr>
<td>Literacy Rate (Value)</td>
<td>Percentage</td>
<td>Female</td>
</tr>
<tr>
<td>Literacy Rate (Value)</td>
<td>Percentage</td>
<td>Male</td>
</tr>
<tr>
<td>Literacy Rate (Numerator)</td>
<td>Count</td>
<td>All</td>
</tr>
<tr>
<td>Literacy Rate (Numerator)</td>
<td>Count</td>
<td>Female</td>
</tr>
<tr>
<td>Literacy Rate (Numerator)</td>
<td>Count</td>
<td>Male</td>
</tr>
<tr>
<td>Literacy Rate (Denominator)</td>
<td>Count</td>
<td>All</td>
</tr>
<tr>
<td>Literacy Rate (Denominator)</td>
<td>Count</td>
<td>Female</td>
</tr>
<tr>
<td>Literacy Rate (Denominator)</td>
<td>Count</td>
<td>Male</td>
</tr>
</tbody>
</table>

5 The creation of DevInfo templates is a fairly complex process, which requires training. A brief overview of this process is given for the sake of completion in this document, but the reader is referred to the DevInfo training manuals and documentation for explicit instructions on how to create DevInfo templates from scratch.

6 In order to export operands from CRIS, you must choose this option during the export process.
In the DevInfo Template module, begin by defining a class and sector for your indicator. Notice that in this example, three separate indicators have been created: one for the value, one for the numerator operand, and one for the denominator operand. Create the appropriate indicator(s) for your own data using the same procedure. Next, create the units and subpopulations by pressing the appropriate icons and completing the dialog boxes. In this example, we will use the unit of “Percentage” for the “Literacy Rate (VALUE)” and “Number” for the operands, i.e. “Literacy Rate (DENOMINATOR)” and “Literacy Rate (NUMERATOR)”.

As discussed above, in addition to creating separate units to store the operands, each of the three indicators must also have corresponding subpopulations, namely “All”, “Female” and “Male”. The next two figures summarize the steps mentioned above.

Once the units and subpopulations are created, an Indicator-Unit-Subpopulation linkage must be established, as seen below. Click the IUS icon and fill in the appropriate linkages using the drop down menus. Of course, it is possible to link the indicator to Goals, Themes, Frameworks, etc as detailed in the DevInfo Administration manuals.
Once the indicator has been created, an IUS linkage can be created, and appropriate classifications assigned, a geographical hierarchy must be imported. This is done with the “Area” function of the DevInfo template module. Click on the “Area” icon ( ), and then “Map” to add geographical information to the template.

In this example, we will import data for the first administrative level for the fictitious country, Popstan. For your own country, use the appropriate name. First, right-click the “Area” folder, and add the region of your country.

Use the following list of AreaID’s depending on where your country is located:

- Africa = AFR
- Asia = ASI
- Europe = EUR
- Latin America = LAC
- North America = NAM
- Oceania (including Australia) = OCN

Once you have defined your region, click the "Map" link and then right-click the region that you created. Now, locate the country-level map. This file should be labeled with RRR_CCC_l0_YYYY.shp, where RRR represents the region of your country, CCC the three-letter ISO code of your country, and YYYY represents the year for which this shape file is valid. Once you have located the shape file, click the "Select All"( ) button to select the desired areas. Press "Apply" to import this file.

Next, the provincial level (First Administrative Level) geographical will be imported. Right click the country name, and locate the appropriate file. This file should have a name like RRR_CCC_l03_YYYY.shp, which indicates it is the first administrative level. Once again, select all the areas to be added, and press "Apply". If you have more administrative levels to import, continue they can be imported using the same procedure as above.

After the hierarchy has been imported through map files, it should be visible in the DevInfo Template panel to the right. At this point, you can save the template (by pressing “File” and then “Save) and move on to importing the IXF data that has been exported previously from CRIS.
Creation of DevInfo worksheets from an IXF file

The DevInfo Data Exchange module is a multipurpose tool capable of importing data from a variety of sources. Here, a procedure will be given for the importation of data from the IXF data exchange format. To proceed, launch the Data Exchange Module and then choose “Tools→DevInfo 4.0 and UNAIDS CRIS XML”. In the first step of the wizard, choose "Exchange Data from UNAIDS CRIS XML to DevInfo 4.0" and click "Next" to proceed.

In the next step of the wizard, you will need to specify the path to three locations:

• The path of the IXF file you wish to import. This file is typically located in the “C:\Program Files\UNAIDS\CRIS21\Data\Export” directory.
• The path of the DevInfo template you have created to import the data into. This is typically located in the “C:\DevInfo\DevInfo 4.0\Templates\” directory.
• The path where the DevInfo Data Entry spreadsheets should be exported to. Typically, the spreadsheets are saved in the “C:\DevInfo\DevInfo 4.0\Spreadsheets” directory, although they can be placed anywhere on your computer if desired. Once all the paths have been defined, you can press “Next” to begin the next step, matching of place names.

Press the “ ” arrow to open a utility that will allow you to check and be sure that all of your place-names have been matched. If they haven’t been matched it will be necessary to match them manually. If the place-names have matched, you should see a matching entry in both the “Source Area” and “Template Area” of the utility. If a match hasn’t been created automatically, then you can click on the area in the upper window, select the matching entry from the list in the “Map” window, and then press “Update” to link the two areas. Once all the place-names have been matched, you can close the place-name matching utility, and press “Next” to proceed to the next step. If all of your place-names have matched properly, you can skip the next step (4 of 6).

7 The DevInfo Data Exchange module employs a special database file to match DevInfo place-names and CRIS place-names (which may be different due to different data sources). At the time of writing, it is only possible to exchange data at the country-level with DevInfo. For subnational data, changes to the mapped.mdb file would need to be made. It is beyond the scope of this document to detail this process. Please contact the DevInfo support unit for further information and assistance.

8 At the time of writing, DevInfo 4.0 was subject to a known bug that mismatches duplicate place-names. If there are any regions contained in the IXF data file that have the same place-name, DevInfo may incorrectly assign the “AreaID” code. This can be corrected during a later step with the DevInfo Template program.
In step (5 of 6) the IXF file will be parsed and will allow the matching of the source indicator data to a DevInfo template indicator. Simply choose the correct DevInfo Sector, Class, Indicator and Unit that corresponds to your indicator from set of drop-down menus. For each indicator in the IXF file, you must match an appropriate Class, Sector, Indicator and Unit. Press the “Next Indicator” button once you have finished assigning each of the DevInfo IUS linkages. Once you have finished importing all your indicators, press “Next” to proceed to the final step. The data exchange utility should inform you that the data exchange has successfully been completed in the final step of the data import wizard.

At this point, DevInfo should have created DevInfo Data Entry worksheets for each of your indicators. These Excel-based worksheets can be used to import data into a DevInfo database.9

**Importation of DevInfo spreadsheets into a DevInfo template**

To begin, open the DevInfo Data Entry utility, and select “Tools → Import Spreadsheets”. Navigate to the location of where the DevInfo spreadsheets were created by the DevInfo Data Exchange utility. Select all of the sheets that you wish to import by double-clicking them. Press "Next" to specify the path to the template you wish to import data into.

Select the template for which you want to import data for by double-clicking it in the left-hand pane of the window. The indicator should appear in the right-hand pane when selected.

9 If any place-names were mismatched during the data import procedure, they can be manually corrected by modifying the DevInfo data entry worksheets that were created by the DevInfo Data Exchange tool. Simply open up the worksheets in Excel, and check all the “AreaID” codes against their corresponding place-names to ensure that they are correct. Once you have corrected all the mismatched place-names, you can proceed to import the data with the DevInfo Data Entry tool.
If there are any unmatched indicators, they can be manually matched in the next step. If the indicators perfectly match in the template and spreadsheet file in terms of spelling, they will be automatically matched and will not appear. They can be shown by clicking the "Show matched" button. Click next to proceed to the next step once all indicators have been matched against the template.

Similar to the previous step, if there are any unmatched units, they will need to be matched in the next step of the importation process. In the example given below, the unit in the data file was spelled "percent" while in the template it was spelled "Percentage". DevInfo will not automatically match these units, but they can be matched by selecting the appropriate unit in the right-hand pane. Click "Next" to proceed to the next step.

If there are any unmatched subpopulations, they can be matched in the fifth step of the import process.
Because of a known issue with DevInfo 4.0, some place-names may be incorrectly generated by the Data Exchange module during importation of the IXF file from CRIS. If there are any unmatched place-names, they can be matched during step six. After all place-names have been matched, press next to save the data to a DevInfo database.

In this step, simply provide a filename for the database, and click "Save" to finish the spreadsheet import process. The final step of the spreadsheet entry process provides information on what data was successfully parsed into the database. Click "Finish" to end the spreadsheet import tool.
Working with DevInfo Data

A brief description of working with data in DevInfo will be given in this section. DevInfo contains much more functionality than what will be described here, including the ability to produce report ready tables, charts and graphs. Additionally, DevInfo is capable of performing basic statistical analysis of data, as well as the ability to generate user-defined indexes. For a complete description of all the features of DevInfo, please refer to the web site (http://www.devinfo.info) or the user manuals supplied with the software.

To begin working with the data that was imported in the previous section, open up the main DevInfo application, and choose the name of the database that was saved in the final step of the importation process.

![DevInfo Interface Image]

Depending on how the template was defined, indicators can be selected in a number of different ways. In this example, the indicator “Literacy rate” was classified as belonging to the Education sector, and can be selected by clicking the “Indicator” button, followed by the appropriate class. By double-clicking the list of indicators in the middle-pane, they can be selected, and appear in the right-hand panel.

To select the time-period, click “Time” and the appropriate time period.

![DevInfo Time Selection Image]
To select the areas for which data is available, click the “Area” button. The auto-filter button (▶) can be pressed to filter out areas for which data is currently available. A dialog box will appear. Press “OK” to select all the areas for which data is available.

A list of areas for which data is available should appear in the right-hand pane, as seen below.

Press the “Data” button to view all the available data in tabular format.
In order to generate a map, click the “Presentation” button, and then the “Map” icon that appears in the screen as shown below.

Various attributes including colors, number of breaks, and the break range for the thematic map can be adjusted in the first step of the wizard that will generate a thematic map. Adjust all the attributes as necessary, and press “Next” to proceed.

In the second step of the wizard, other attributes of the map, such as the title and layout can be adjusted.
The third step of the wizard allows other customization options, such as the importation of other layers such as roads and rivers. Please refer to the DevInfo user-manual for complete instructions.

In the fourth and fifth step of the wizard, the map will be generated, and can be saved for future retrieval.

**Conclusions**

Compared to the other software programs described in this paper, there are significantly more steps required to import data from CRIS into DevInfo. Additionally, all indicators, areas and time periods for which data will be imported must be defined beforehand through the DevInfo template module. This requires detailed, *prima facie* knowledge of the content of the IXF data file. Compared to KIDS and HealthMapper, a large amount of work would be required to import data files with many indicators, time periods, and/or stratification. Nonetheless, DevInfo is a capable software tool that is widely used at the country and international level. Future versions of DevInfo plan to enhance support for the IXF data standard, which should simplify the data import process.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data collection</td>
<td>No systematic support although data can be imported through spreadsheets or IXF files.</td>
</tr>
<tr>
<td>Graphing</td>
<td>Support for graphing is provided through a set of user-friendly wizards.</td>
</tr>
<tr>
<td>Mapping</td>
<td>Excellent support for thematic maps.</td>
</tr>
<tr>
<td>Tables</td>
<td>Yes, a wide-variety of report-ready reports can be generated through the user-friendly wizard.</td>
</tr>
<tr>
<td>Stratification</td>
<td>DevInfo employs a slightly different approach to stratification, as mentioned above. Any given indicator can have essentially any type of Indicator-Unit-Subpopulation linkage. When employed correctly, this scheme can be used to represent stratified indicators (as they are used in CRIS). However, the indicators in DevInfo are not dynamically linked, and therefore stratification units cannot be used to calculate an overall total for a given indicator automatically.</td>
</tr>
<tr>
<td>Data exchange</td>
<td>Import and export capabilities through the IXF data exchange standard using the DevInfo Data Exchange program has been prototyped.</td>
</tr>
<tr>
<td>Stratified indicators</td>
<td>The concept of stratified indicators as used in CRIS is slightly different than DevInfo. Generally, stratified indicators can be imported from CRIS and represented in DevInfo, however, they are stored as separated, unassociated indicators. In CRIS, each stratification component is linked to a single indicator, and is aggregated automatically by the application to a final, overall value. In DevInfo, indicators are stratified according to subpopulations and units.</td>
</tr>
<tr>
<td>Technology</td>
<td>DevInfo 4.0 is based on VisualBasic® 6.0 technology and makes extensive use of Microsoft Office automation and ESRI’s MapObjects® for thematic mapping. DevInfo employs Microsoft’s Access 97® database format for storage and retrieval of data. DevInfo’s different utilities allow the effective distribution of work throughout the creation of a DevInfo database.</td>
</tr>
</tbody>
</table>
Data transfer between CRIS and HealthMapper

Special considerations

The importation of data from CRIS to HealthMapper depends crucially upon place-names matching in the source XML file, and the database of HealthMapper. In general, this matching process shouldn’t be a problem, as CRIS relies on the same geoplacename database as HealthMapper. However, if the CRIS place-name database has been modified to reflect changes in a national or regional geopolitical hierarchy, there could be problems importing data. It is beyond the scope of this document to detail how to make changes to either the CRIS or HealthMapper geoplacename database. If changes to the geoplacename database has been made in either application, special steps will be required to ensure that data can be imported seamlessly from CRIS. Contact the CRIS Unit and/or your WHO Country Office for more support on this issue.

Data transfer between CRIS and HealthMapper is straightforward and simple, assuming you have an appropriate HealthMapper project. Creation of a HealthMapper project is a complex process, and beyond the scope of this document. Please consult the HealthMapper support team for further information if one doesn’t already exist for your country or region.

To begin, you will need to locate the IXF files that have been exported from CRIS, (typically located in C:\Program Files\UNAIDS\CRIS21\Data\Export directory) and rename it so that the HealthMapper Data Manager program can import it. HealthMapper only imports files with the “XML” extension. Once you have located the file of interest, right-click the file from within Windows Explorer and choose “Rename” from the drop-down menu. Simply rename the file to something with an XML extension. Typically, CRIS files have names like this and end in the “.CRIS” extension as seen below:

\[IND_ZZ-00-Popstan-UNAIDS(JointU-2006-02-0911-26-17-260.CRIS\]

In this exercise, this file will be imported to HealthMapper. It has been renamed to:

\[Literacy_Rate.xml\]

Choose a descriptive filename so that you can easily locate the file again.

Importing IXF Data with HealthMapper

Data import of an IXF file into HealthMapper is a simple process. To import data from an IXF file, follow these steps:

1. Open the HealthMapper Data Manager.
2. Choose “File→Import Data→Import XML Data”.

---

10 CRIS files are actually XML files, but use the CRIS extension in order to ensure that they can be sent through e-mail. XML files are often blocked by corporate e-mail servers.
3. Click “Browse” to locate the XML file. If you haven’t moved the file after you renamed it, it should be located in “C:\Program Files\UNAIDS\CRIS21\Data\Export”. Once you have located the file, click it. The path to the file should appear now as seen below.

![Image of Load Data From XML File dialog box]

4. Click “Load XML Data” to begin to import the data. If the data importation was successful, you should see a dialog box confirming this.

![Image of HealthMap Data Manager dialog box]

Once the data has been imported, you can exit the Data Manager and begin to work with the data in HealthMapper.

**Creating a thematic map with HealthMapper**

HealthMapper is capable of generating thematic maps and graphs, along with adding additional geographic information such as roads, rivers, population centers, health centers, etc. An abbreviated procedure will be given here, describing how to create a thematic map from imported XML data.

From the main window of HealthMapper, choose “File→New Map”. Select the geographical level for which you want to generate a map. In this example, the "District" level of the fictitious country "Popstan" will be used. Individual areas can be selected using the window pane, or you can press "Select all" to choose all areas.

Once you have selected all the regions you want to generate a map for, press the "Create Map" button to proceed. Once the map window appears, click the layer of interest. In this case, "District" is chosen, since a thematic map of data at the district level will be generated. Once you have selected the level of interest, click "Overlay Indicator" to generate the thematic map.
A wizard will guide you through the steps necessary to generate your map. Choose the indicator that you wish to plot. In this example, the indicator "Literacy Rate-(TEST)" was chosen from the "Imported XML Indicators" category.

Select the subpopulation of interest.

Select "Actual data.

Select the time period.
Select the source and click “Finish” to generate the thematic map for the data set you have chosen.

From the map seen below, it can be seen that there is a strong correlation between the geographical position of each district, and the literacy rate. The map shows that the southern provinces of Popstan exhibit significantly lower literacy rates than the northern districts. This example shows how geographical trends become readily apparent when visualized on a thematic map, which might otherwise be very difficult to detect when analyzing the data in the form of charts or tables.

Conclusions

HealthMapper’s user-friendly interface and advanced data management and reporting functionality provide a powerful data analysis and visualization platform. Additionally, HealthMapper comes prepackaged with useful geographical information such as roads, rivers, health facilities, etc, that is unique when compared to KIDS or DevInfo. One drawback with HealthMapper however is unlike KIDS or DevInfo, there is no way to create your own project. If the geographical place-names contained in the HealthMapper project, differ from those in the CRIS IXF file, the geographical place-names and boundary files will need to be updated in the HealthMapper project. WHO has developed HealthMapper projects for many countries, but if one doesn’t exist for your country, please contact the WHO HealthMapper support unit for further information.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data collection</td>
<td>No systematic support although the use of IXF files should allow systematic collection from different sources.</td>
</tr>
<tr>
<td>Graphing</td>
<td>A wide variety of two- and three-dimensional graphs are offered with HealthMapper.</td>
</tr>
<tr>
<td>Mapping</td>
<td>Excellent support for thematic maps. HealthMapper is prepackaged with a variety of supporting geographical information such as roads, rivers, and health facility locations.</td>
</tr>
<tr>
<td>Tables</td>
<td>Tables in the form of reports can be generated through the HealthMapper Data Manager. The reports can then be exported to a wide-variety of formats for further editing.</td>
</tr>
<tr>
<td>Stratification</td>
<td>HealthMapper supports stratified indicator but is limited to stratification by subpopulation, time and data source. Internal query indicators could be defined to automatically calculate totals for stratified indicators.</td>
</tr>
<tr>
<td>Data exchange</td>
<td>Yes, import and export capabilities through the IXF data exchange standard. Currently, the version that supports exchange through the IXF data standard has been prototyped.</td>
</tr>
<tr>
<td>Stratified indicators</td>
<td>HealthMapper automatically imports stratified indicators defined in CRIS, but they become defined in terms of separate, unassociated indicators.</td>
</tr>
<tr>
<td>Technology</td>
<td>HealthMapper is based on VisualBasic 6.0 with extensive use of custom Access 97 databases. Report generation is managed through custom modules created with Business Objects Crystal Reports®. Mapping technology (including editing shapefiles, importing GPS data etc) is enabled with ESRI’s ArcObjects®.</td>
</tr>
</tbody>
</table>
Summary

This document has sought to detail current procedures of how to import IXF data files exported from CRIS into UNICEF’s DevInfo, FAO’s KIDS, and WHO’s HealthMapper program. This guide has provided step-by-step instructions of how to import data and create thematic maps from data that has originated from CRIS for a single country. The same procedures can be used regardless of the type of data. CRIS supports the warehousing of data at the international, regional, national and subnational levels, for different time periods. Given this flexibility, it is impossible to describe in detail exactly how to import every possible data set. However, the procedures outlined in this document should be able to be successfully adapted to essentially any country or regional data set.

In conclusion, the newly developed IXF data standard, and implementation of this standard in each piece of software reviewed in this paper, will open up new possibilities for data exchange between respective UN organizations. Although most present applications are focused on mapping and visualization, the IXF standard should open many new avenues to interoperability between applications. The standard effectively addresses the problem of how to exchange data between respective database systems, regardless of their exact functionality. Data exchange between systems and agencies has long been an impediment to effective data flow, with users sometimes forced to decide which system to choose over another. However, the IXF data exchange standard will allow users to leverage the strengths of each application in its own right, without worrying about how and whether data can be imported between applications. Planned enhancements to the XML schema will provide enhanced support for project and resource tracking data to further support data exchange among different M&E systems. The planned new version of CRIS will include a tool to facilitate the integration of local systems using the UNAIDS sponsored transmission format for M&E data. The other applications reviewed here also plan to enhance the data exchange capability of their respective applications as well. Hopefully, with these new advancements in technology and cooperation, all data will be able to be used more effectively for furthering the humanitarian mission of the United Nations, regardless of where or how it is stored.

About the Author

Jason Pickering is an independent GIS and database consultant. He received his undergraduate degree from the Georgia Institute of Technology in Atlanta, GA, USA and his PhD from the University of Twente in the Netherlands. He is a certified trainer of both DevInfo 4.0 and CRIS, and an active contributor and tester for the KIDS project. He has conducted CRIS trainings and implementations in several countries in Asia and Africa and has contributed to the national implementation of DevInfo in Myanmar.
This guide on data exchange between the Country Response Information System (CRIS) and UN Agency Software is the part of a continuing series. It is intended primarily for M&E Officers in the field, who wish to exchange data between CRIS and UNICEF’s DevInfo program, FAO KIDS platform, and WHO’s HealthMapper program.